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Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Product Name HP EliteBook Revolve 810 G1

Processors ● Intel® Dual Core® i7-3687U 2.10-GHz processor (turbo up to 3.30-GHz), 1600-MHz
front-side bus (FSB), 4.00-MB L3 cache, 17 W

● Intel Dual Core i5-3437U 1.90-GHz processor (turbo up to 2.90-GHz), 1600-MHz FSB,
3.00-MB L3 cache, 17 W

● Intel Dual Core i3-3227U 1.90-GHz processor, 1600-MHz FSB, 3.00-MB L3 cache,
17 W

Chipset Mobile Intel QM77 PCH chipset

Graphics Intel HD Graphics 4000 integrated universal memory architecture (UMA) graphics

Support for dual-display ports through the dock

Panel 11.6-in high-definition (HD), light-emitting diode (LED), AntiGlare (AG), UWVA (1366×768),
ultraslim display with webcam and microphone

Touchscreen enabled

Typical brightness: 400 nits

Memory One customer-accessible/upgradable memory module slot + 4-GB on the system board

Support for DDR3L PC-3 12800 (1600-MHz)

Support for 12288-MB of system RAM in the following configurations:

● 12288-MB (8192-MB memory module + 4096-MB on system board)

● 8192-MB (4096-MB memory module + 4096-MB on system board)

● 4096-MB (4096-MB on system board)

Solid-state drive Support for mSATA solid-state drives

Serial ATA III

Support for the following single solid-state drive configurations:

● 256-GB mSATA

● 128-GB mSATA
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Category Description

Audio and video DTS Studio sound

Integrated dual-array microphones

Stereo speakers (2)

Camera 720p

 Camera 720p Stereo Speakers (2)

Ethernet Integrated Intel 82579LM 10/100/1000 network interface card (NIC)

Wireless Integrated wireless personal area network (WPAN) option supported only through
combination module

 Two WLAN antennas built into display assembly

 Integrated wireless local area network (WLAN) options by way of wireless module

Support for the following WLAN modules:

● Intel Centrino Advanced-N 6235 Combo Adapter

● Intel Centrino Advanced-N 6205 Combo Adapter

 Support for no WLAN/Bluetooth option

 Two WWAN antennas built into display assembly

 Integrated wireless wide area network (WWAN) options by way of wireless module

Support for the following WWAN modules:

● HP un2430 EV-DO/HSPA Mini Card

● HP hs2350 HSPA+ Mobile Broadband Module

 WWAN secured by micro-SIM

 Support for no WWAN option

 Support for WWAN after market option

 Integrated near field communication (NFC) module and antenna

External media cards Micro-Secure Digital slot

 Combo Headphone/MIC jack side docking connector

Ports ● AC adapter

● Audio-in (mono microphone)/audio-out (stereo headphone) combination

● DisplayPort 1.1a

● Docking

● RJ-45 (Ethernet)

● USB 3.0 (2)
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Category Description

Sensors ● Accelerometer

● ALS

● Compass

● Gyro

● NFC with Secure Element

● Proximity (SAR)

Docking 2013 UltraSlim Docking Station

Keyboard/pointing
devices

Full-size, backlit, spill-reistant keyboard with DuraKeys and active pen

Gesture support: MultiTouch gestures enabled, two-finger scrolling, and pinch-
zoom as default

Taps enabled by default

Support for ClickPad with image sensor, scroll, pinch, zoom, rotate, and 3-finger flick)

Power requirements Support for 65-W HP Smart AC adapter (RC, V, EM, 3-wire) and 45-W HP Smart AC
adapter (RC, V, non-PFC, 3-wire)

 Support for 6-cell, 44-Wh, 1.98-Ah, Li-ion battery (Li-ion)

Security ● Support for security cable lock

● Support for Trusted Platfom Module (TPM) 1.2 Enhanced Drive Lock

● HP ProtectTools (Limited Suite)

● HP Power Assistant

● Preboot Authentication (Password)
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Category Description

Operating system Preinstalled:

● Windows® 8 ML 64-bit with Microsoft® Basics (Japanese and Japanese English only)

● Windows 8 Professional 64-bit DPK with Windows 7 Professional 64-bit image
(Japanese and Japanese English only)

● Windows 8 Professional 64-bit with Microsoft Basics (Japanese and Japanese
English only)

● Windows 7 Home Premium 64-bit with Microsoft Basics (includes Service Pack 1;
Japanese and Japanese English only)

● Windows 7 Professional 64-bit with Microsoft Basics (includes Service Pack 1; Japanese
and Japanese English only)

● FreeDos 2.0

Preinstalled with Microsoft Office:

● Windows 8 CH 64-bit with Microsoft Office 2010 Transition OPK (People's Republic
of China only)

● Windows 8 EM 64-bit with Microsoft Office 2010 Transition OPK (not available
in Japan)

● Windows 8 ML 64-bit with Microsoft Office 2010 Home and Business (Japan only)

● Windows 8 ML 64-bit with Microsoft Office 2010 Personal (Japan only)

● Windows 8 ML 64-bit with Microsoft Office 2010 Professional (Japan only)

● Windows 8 ML 64-bit with Microsoft Office 2010 Transition OPK (not available
in Japan)

● Windows 8 Professional 64-bit with Microsoft Office 2010 Home and Business
(Japan only)

● Windows 8 Professional 64-bit with Microsoft Office 2010 Personal (Japan only)

● Windows 8 Professional 64-bit with Microsoft Office 2010 Professional (Japan only)

● Windows 8 Professional 64-bit with Microsoft Office 2010 Transition OPK (not
available in Japan)

● Windows 8 Professional 64-bit DPK with Windows 7 Professional 64-bit image and
Microsoft Office 2010 Home and Business (Japan only)

● Windows 8 Professional 64-bit DPK with Windows 7 Professional 64-bit image and
Microsoft Office 2010 Personal (Japan only)

● Windows 8 Professional 64-bit DPK with Windows 7 Professional 64-bit image and
Microsoft Office 2010 Transition OPK (not available in Asia Pacific, Japan, or the
People's Republic of China)

● Windows 8 Professional 64-bit DPK with Windows 7 Professional 64-bit image DPK
and Microsoft Office 2010 Professional (Japan only)
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Category Description

Operating system
(continued)

Preinstalled with Microsoft Office: (continued)

● Windows 7 Home Premium 64-bit with Microsoft Office 2010 Home and Business
(Japan only; includes Service Pack 1)

● Windows 7 Home Premium 64-bit with Microsoft Office 2010 Personal (Japan only;
includes Service Pack 1)

● Windows 7 Home Premium 64-bit with Microsoft Office 2010 Professional (Japan only;
includes Service Pack 1)

● Windows 7 Home Premium 64-bit with Microsoft Office 2010 Transition OPK (not
available in Japan; includes Service Pack 1)

● Windows 7 Professional 64-bit with Microsoft Office 2010 Home and Business
(Japan only; includes Service Pack 1)

● Windows 7 Professional 64-bit with Microsoft Office 2010 Personal (Japan only;
includes Service Pack 1)

● Windows 7 Professional 64-bit with Microsoft Office 2010 Professional (Japan only;
includes Service Pack 1)

● Windows 7 Professional 64-bit with Microsoft Office 2010 Transition OPK (not
available in Japan; includes Service Pack 1)

Restore Media–DRDVD:

● DRDVD Windows 8: Available with Windows 8 or Windows 8 Professional Loc
required with any Windows 7 Professional downgrade operating system

● DRDVD Windows 7: Available with Windows 7 Home Premium or Windows 7
Professional downgrade

Restore Media–OSDVD:

● Windows 8 Professional 64-bit: Available only and required with Windows 7
Professional downgrade operating system

● Windows 7 Home Premium 64-bit: Available with Windows 7 Home Premium Loc (not
available in Asia Pacific or the People's Republic of China)

● Windows 7 Professional 64-bit: Available with Windows Professional Loc or Windows
7 Professional downgrade loc (not available in Asia Pacific or the People's Republic
of China)

Certified: Microsoft WHQL
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Category Description

Operating system
(continued)

Web-only support: (continued)

● Windows 8 32-bit

● Windows 8 CH 32-bit

● Windows 8 EM 32-bit

● Windows 8 Enterprise 64-bit

● Windows 8 Enterprise 32-bit

● Windows 8 ML 32-bit

● Windows 8 Professional 32-bit

● Windows 7 Home Basic 64-bit

● Windows 7 Home Basic 32-bit

● Windows 7 Home Premium 32-bit

● Windows 7 Professional 32-bit

● Windows 7 Ultimate 64-bit

● Windows 7 Ultimate 32-bit

Serviceability End user replaceable part: AC adapter

● AC adapter

● Battery

● Memory module

● mSATA solid-state drive

● 2013 UltraSlim Docking Station

● WLAN module

● WWAN module

6 Chapter 1   Product description



2 External component identification
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CAUTION: To prevent damage to the display hinges, when in notebook configuration, do not rotate
the display counterclockwise, and do not force the rotating action.

To change your notebook to a tablet

1. Rotate the display clockwise 180 degrees until the display faces backwards.

2. Lower the display over the keyboard.

To change the tablet back into a notebook, reverse these steps.
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Display

Item Component Description

(1) WLAN antennas (2)* Send and receive wireless signals to communicate with
wireless local area networks (WLAN).

(2) Ambient light sensor Brightens or dims the display in response to
ambient light.

(3) WWAN antennas (2)* Send and receive wireless signals to communicate with
wireless wide area networks (WWAN).

(4) Internal microphones (2) Record sound.

(5) Webcam light On: The webcam is in use.

(6) Webcam Records video and captures still photographs. For
information on using the webcam, access HP Support
Assistant. To access HP Support Assistant on the Start
screen, select the HP Support Assistant app.

(7) Windows Home button Returns you to the Start screen.

*The antennas are not visible on the outside of the computer. For optimal transmission, keep the areas immediately around the
antennas free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety, and Environmental
Notices that applies to your country or region. To access the user guides, select the HP Support Assistant app on the Start
screen, select My computer, and then select User guides.
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Keys
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) esc key Displays system information when pressed in combination
with the fn key.

(2) fn key Executes frequently used system functions when pressed
in combination with a function key, the num lk key, the
esc key, or the b key.

(3) Windows button Returns you to the Start screen from an open app or the
Windows desktop.

NOTE: Pressing the Windows button again will return
you to the previous screen.

(4) Function keys Execute frequently used system functions when pressed in
combination with the fn key.

(5) Embedded numeric keypad When the keypad is turned on, it can be used like an
external numeric keypad. Each key on the keypad
performs the function indicated by the icon in the upper-
right corner of the key.

(6) Windows application key Displays options for a selected object.
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Lights
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Caps lock light On: Caps lock is on.

(2) Mute light ● Amber: Computer sound is off.

● Off: Computer sound is on.

(3) Microphone mute light ● Amber: Muted.

● Off: Microphone is on.

(4) Wireless light ● White: An integrated wireless device, such as a
WLAN device and/or a Bluetooth device, is on.

● Amber: All wireless devices are off.

(5) Num lock light On: Num lock is on.

(6) TouchPad light ● Amber: The TouchPad is off.

● Off: The TouchPad is on.
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TouchPad
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) TouchPad on/off button Turns the TouchPad on or off.

(2) TouchPad zone Moves the pointer and selects or activates items on
the screen.

(3) Left TouchPad button Functions like the left button on an external mouse.

(4) Right TouchPad button Functions like the right button on an external mouse.

Left side
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(2) Speaker Produces sound.
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Rear
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) RJ-45 (network) jack Connects a network cable.

(2) USB 3.0 ports (1) USB 3.0 ports (1) Connect optional USB 3.0 devices and
provide enhanced USB power performance.

(3) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

(4) DisplayPort Connects an optional digital display device, such as a
high-performance monitor or projector.

(5) USB 3.0 charging port USB 3.0 charging port Connects an optional USB device.
The USB 3.0 charging port can also charge select models
of cell phones and MP3 players, even when the computer
is off.

NOTE: A USB charging port (also referred to as a
powered USB port) allows you to charge connected USB
devices. Standard USB ports will not charge all USB
devices or will charge using a low current. Some USB
devices require power and require you to use a
powered port.

(6) Power connector Connects an AC adapter.

(7) AC adapter light ● White: The AC adapter is connected and the battery
is charged.

● Amber: The AC adapter is connected and the
battery is charging.

● Off: The computer is using DC power.
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Right side

Item Component Description

(1) Power button Turns power on and off.

(2) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state.

● Off: The computer is off.

(3) Rotation lock button Locks screen orientation in either Landscape or
Portrait mode.

NOTE: When you move between notebook and tablet
configuration, the computer screen will automatically
change to vertical or horizontal. To lock the current
screen orientation, slide the screen orientation button.

(4) Volume button Lowers the volume.

(5) Volume button Raises the volume.

(6) Speaker Produces sound.

(7) Media Card Reader Supports a micro SD High Capacity (SDHC) memory
card or an optional wireless micro subscriber identity
module (SIM).

(8) Audio-out (headphone) jack/Audio-in
(microphone) jack

Produces sound when connected to optional powered
stereo speakers, headphones, earbuds, a headset, or
television audio. Also connects an optional headset
microphone.

WARNING! To reduce the risk of personal injury,
adjust the volume before putting on headphones,
earbuds, or a headset. For additional safety information,
see the Regulatory, Safety, and Environmental Notices.
To access the user guides, select the HP Support
Assistant app on the Start screen, select My
computer, and then select User guides.

NOTE: When a device is connected to the jack, the
computer speakers are disabled.

NOTE: Be sure that the device cable has a 4-
conductor connector that supports both audio-out
(headphone) and audio-in (microphone).

(9) Docking port Connects an optional docking device.

14 Chapter 2   External component identification



Bottom
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Service cover Contains the hard drive, the WLAN module slot, the
WWAN module slot (select models only), and the
memory module slots.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore
computer functionality, and then contact support through
HP Support Assistant. To access HP Support Assistant
on the Start screen, select the HP Support Assistant
app.

(2) Vents Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(3) Near Field Communication (NFC) antenna With HP TouchZone, you can wirelessly connect,
communicate, and transfer data/information to and from
your NFC-compatible devices.

(4) Battery bay Holds the battery.

(5) Battery bay cover release latch Releases the battery cover over the battery bay.
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3 Illustrated parts catalog
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Service tag
When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag. It is necessary to remove the battery to obtain these numbers. See Battery
on page 33 for battery removal instructions.

Item Description Function

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

(3) Part number/Product number (p/n) This number provides specific information about
the product's hardware components. The part number
helps a service technician to determine what
components and parts are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.
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Computer major components
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Item Component Spare part number

(1) Display assembly, 11.6-in, AntiGlare (1366×768), HD, UWVA (includes display
hinge, microphones, webcamera, and Windows button)

716734-001

(2a) Hinge cover (includes hinge cap (2b), WWAN antenna cables and transceivers,
and WWAN antenna cable shield)

716743-001

(3) Keyboard with backlight (includes backlight cable and keyboard cable):

 For use in Belgium 716747-A41

 For use in Brazil 716747-201

 For use in Bulgaria 716747-261

 For use in Canada 716747-DB1

 For use in the Czech Republic and Slovakia 716747-FL1

 For use in Denmark 716747-081

 For use in France 716747-051

 For use in Germany 716747-041

 For use in Greece 716747-151

 For use in Hungary 716747-211

 For use in Iceland 716747-DD1

 For use in India 716747-D61

 For use in Israel 716747-BB1

 For use in Italy 716747-061

 For use in Japan 716747-291

 For use in Latin America 716747-161

 For use in the Netherlands 716747-B31

 For use in Norway 716747-091

 For use in Northwest Africa 716747-FP1

 For use in Portugal 716747-131

 For use in Romania 716747-271

 For use in Russia 716747-251

 For use in Saudi Arabia 716747-171

 For use in Slovenia 716747-BA1

 For use in South Korea 716747-AD1

 For use in Spain 716747-071

 For use in Sweden and Finland 716747-B71

 For use in Switzerland 716747-BG1
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Item Component Spare part number

 For use in Taiwan 716747-AB1

 For use in Thailand 716747-281

 For use in Turkey 716747-141

 For use in the United Kingdom and Singapore 716747-031

 For use in the United States 716747-001

(4) Top cover (includes display lid switch actuator magnets, orientation lock switch
actuator, power switch actuator, TouchPad, and TouchPad cable)

716741-001

(5) System board (includes processor, replacement thermal material, and RTC battery):

 Equipped with an Intel Dual Core i7-3687U 2.10-GHz (turbo up to 3.30-GHz), 1600-
MHz FSB, 4.00-MB L3 cache, 17 W, and the Windows 8 Professional
operating system

716733-601

 Equipped with an Intel Dual Core i7-3687U 2.10-GHz (turbo up to 3.30-GHz), 1600-
MHz FSB, 4.00-MB L3 cache, 17 W, and the Windows 8 Standard operating system

716733-501

 Equipped with an Intel Dual Core i7-3687U 2.10-GHz (turbo up to 3.30-GHz), 1600-
MHz FSB, 4.00-MB L3 cache, 17 W, and the Windows 7 operating system

716733-001

 Equipped with an Intel Dual Core i5-3437U 1.90-GHz (turbo up to 2.90-GHz), 1600-
MHz FSB, 3.00-MB L3 cache, 17 W, and the Windows 8 Professional
operating system

716732-601

 Equipped with an Intel Dual Core i5-3437U 1.90-GHz (turbo up to 2.90-GHz), 1600-
MHz FSB, 3.00-MB L3 cache, 17 W, and the Windows 8 Standard operating system

716732-501

 Equipped with an Intel Dual Core i5-3437U 1.90-GHz (turbo up to 2.90-GHz), 1600-
MHz FSB, 3.00-MB L3 cache, 17 W, and the Windows 7 operating system

716732-001

 Equipped with an Intel Dual Core i3-3227U 1.90-GHz processor, 1600-MHz FSB,
3.00-MB L3 cache, 17 W, and the Windows 8 Professional operating system

716731-601

 Equipped with an Intel Dual Core i3-3227U 1.90-GHz processor, 1600-MHz FSB,
3.00-MB L3 cache, 17 W, and the Windows 8 Standard operating system

716731-501

 Equipped with an Intel Dual Core i3-3227U 1.90-GHz processor, 1600-MHz FSB,
3.00-MB L3 cache, 17 W, and the Windows 7 operating system

716731-001

(6) Fan/heat sink assembly (includes replacement thermal material) 716736-001

(7) RTC battery (includes cable and double-sided adhesive) 716742-001

(8) Bottom cover (includes battery release latch, NFC board antenna cable, power
connector cover, and RJ-45 jack cover)

716739-001

(9) Button board (includes cable) 716735-001

(10) Speaker Kit (includes left and right speakers and cables) 716740-001

(11) NFC board (includes cable) 716738-001

(12) Memory module (PC3L, 12800, 1600-MHz):

 8-GB 693374-001

 4-GB 691740-001
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Item Component Spare part number

(13) Solid-state drive:

 256-GB 716749-001

 128-GB 716748-001

(14) WWAN module:

 HP un2430 EV-DO/HSPA Mini Card 702080-001

 HP hs2350 HSPA+ Mobile Broadband Module 710788-001

(15) WLAN module:

 Intel Centrino Advanced-N 6235 Combo Adapter 670292-001

 Intel Centrino Advanced-N 6205 Combo Adapter 695915-001

(16) Service cover (includes 4 captive retention screws and 2 rubber feet) 716737-001

 Plastics/Rubber Kit (not illustrated, includes 4 service cover rubber screw covers
and micro SD Card bezel

716744-001

(17) 6-cell, 44-Wh, 1.98-Ah, Li-ion battery (includes rubber feet and speaker grilles) 698943-001

Miscellaneous parts

Component Spare part number

AC adapter:

65-W HP Smart AC adapter (RC, V, EM, 3-wire) 693710-001

45-W HP Smart AC adapter (RC, V, non-PFC, 3-wire) 696694-001

Digitizer pen 716746-001

Power cord (3-pin, black, 1.83-m):

For use in Australia 490371-011

For use in Brazil 490371-202

For use in Denmark 490371-081

For use in Europe 490371-021

For use in Israel 490371-BB1

For use in Italy 490371-061

For use in Japan 490371-291

For use in North America 490371-001

For use in the People's Republic China 490371-AA1

For use in South Korea 490371-AD1
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Component Spare part number

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1

For use in Thailand 490371-201

For use in the United Kingdom and Singapore 490371-031

Screw Kit 713745-001

Sequential part number listing

Spare part number Description

490371-001 Power cord for use in North America (3-pin, black, 1.83-m)

490371-011 Power cord for use in Australia (3-pin, black, 1.83-m)

490371-021 Power cord for use in Europe (3-pin, black, 1.83-m)

490371-031 Power cord for use in the United Kingdom and Singapore (3-pin, black, 1.83-m)

490371-061 Power cord for use in Italy (3-pin, black, 1.83-m)

490371-081 Power cord for use in Denmark (3-pin, black, 1.83-m)

490371-111 Power cord for use in Switzerland (3-pin, black, 1.83-m)

490371-201 Power cord for use in Thailand (3-pin, black, 1.83-m)

490371-202 Power cord for use in Brazil (3-pin, black, 1.83-m)

490371-291 Power cord for use in Japan (3-pin, black, 1.83-m)

490371-AA1 Power cord for use in the People's Republic of China (3-pin, black, 1.83-m)

490371-AB1 Power cord for use in Taiwan (3-pin, black, 1.83-m)

490371-AD1 Power cord for use in South Korea (3-pin, black, 1.83-m)

490371-BB1 Power cord for use in Israel (3-pin, black, 1.83-m)

670292-001 Intel Centrino Advanced-N 6235 Combo Adapter

691740-001 4-GB memory module (PC3L, 12800, 1600-MHz)

693374-001 8-GB memory module (PC3L, 12800, 1600-MHz)

693710-001 65-W HP Smart AC adapter (RC, V, EM, 3-wire)

695915-001 Intel Centrino Advanced-N 6205 Combo Adapter

696694-001 45-W HP Smart AC adapter (RC, V, non-PFC, 3-wire)

698943-001 6-cell, 44-Wh, 1.98-Ah, Li-ion battery (includes rubber feet and speaker grilles)

702080-001 HP un2430 EV-DO/HSPA Mini Card

710788-001 HP hs2350 HSPA+ Mobile Broadband Module
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Spare part number Description

716731-001 System board equipped with an Intel Dual Core i3-3227U 1.90-GHz processor, 1600-MHz FSB,
3.00-MB L3 cache, 17 W, and the Windows 7 operating system (includes processor, replacement
thermal material, and RTC battery)

716731-501 System board equipped with an Intel Dual Core i3-3227U 1.90-GHz processor, 1600-MHz FSB,
3.00-MB L3 cache, 17 W, and the Windows 8 Standard operating system (includes processor,
replacement thermal material, and RTC battery)

716731-601 System board equipped with an Intel Dual Core i3-3227U 1.90-GHz processor, 1600-MHz FSB,
3.00-MB L3 cache, 17 W, and the Windows 8 Professional operating system (includes processor,
replacement thermal material, and RTC battery)

716732-001 System board equipped with an Intel Dual Core i5-3437U 1.90-GHz (turbo up to 2.90-GHz),
1600-MHz FSB, 3.00-MB L3 cache, 17 W, and the Windows 7 operating system (includes
processor, replacement thermal material, and RTC battery)

716732-501 System board equipped with an Intel Dual Core i5-3437U 1.90-GHz (turbo up to 2.90-GHz),
1600-MHz FSB, 3.00-MB L3 cache, 17 W, and the Windows 8 Standard operating system
(includes processor, replacement thermal material, and RTC battery)

716732-601 System board equipped with an Intel Dual Core i5-3437U 1.90-GHz (turbo up to 2.90-GHz),
1600-MHz FSB, 3.00-MB L3 cache, 17 W, and the Windows 8 Professional operating system
(includes processor, replacement thermal material, and RTC battery)

716733-001 System board equipped with an Intel Dual Core i7-3687U 2.10-GHz (turbo up to 3.30-GHz),
1600-MHz FSB, 4.00-MB L3 cache, 17 W, and the Windows 7 operating system (includes
processor, replacement thermal material, and RTC battery)

716733-501 System board equipped with an Intel Dual Core i7-3687U 2.10-GHz (turbo up to 3.30-GHz),
1600-MHz FSB, 4.00-MB L3 cache, 17 W, and the Windows 8 Standard operating system
(includes processor, replacement thermal material, and RTC battery)

716733-601 System board equipped with an Intel Dual Core i7-3687U 2.10-GHz (turbo up to 3.30-GHz),
1600-MHz FSB, 4.00-MB L3 cache, 17 W, and the Windows 8 Professional operating system
(includes processor, replacement thermal material, and RTC battery)

716734-001 11.6-in, AntiGlare (1366×768), HD, UWVA display assembly (includes display hinge,
microphones, webcamera, and Windows button)

716735-001 Button board (includes cable)

716736-001 Fan/heat sink assembly (includes replacement thermal material)

716737-001 Service cover (includes 4 captive retention screws and 2 rubber feet)

716738-001 NFC board (includes cable)

716739-001 Bottom cover (includes battery release latch, NFC board antenna cable, power connector cover,
and RJ-45 jack cover)

716740-001 Speaker Kit (includes left and right speakers and cables)

716741-001 Top cover (includes display lid switch actuator magnets, orientation lock switch actuator, power
switch actuator, TouchPad, and TouchPad cable)

716742-001 RTC battery (includes cable and double-sided adhesive)

716743-001 Hinge cover (includes hinge cap, WWAN antenna cables and transceivers, and WWAN antenna
cable shield)

716744-001 Plastics/Rubber Kit (includes 4 service cover rubber screw covers and micro SD Card bezel)
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Spare part number Description

716745-001 Screw Kit

716746-001 Digitizer pen

716747-001 Keyboard with backlight for use in the United States (includes backlight cable and keyboard cable)

716747-031 Keyboard with backlight for use in the United Kingdom and Singapore (includes backlight cable
and keyboard cable)

716747-041 Keyboard with backlight for use in France (includes backlight cable and keyboard cable)

716747-051 Keyboard with backlight for use in Germany (includes backlight cable and keyboard cable)

716747-061 Keyboard with backlight for use in Italy (includes backlight cable and keyboard cable)

716747-071 Keyboard with backlight for use in Spain (includes backlight cable and keyboard cable)

716747-081 Keyboard with backlight for use in Denmark (includes backlight cable and keyboard cable)

716747-091 Keyboard with backlight for use in Norway (includes backlight cable and keyboard cable)

716747-131 Keyboard with backlight for use in Portugal (includes backlight cable and keyboard cable)

716747-141 Keyboard with backlight for use in Turkey (includes backlight cable and keyboard cable)

716747-151 Keyboard with backlight for use in Greece (includes backlight cable and keyboard cable)

716747-161 Keyboard with backlight for use in Latin America (includes backlight cable and keyboard cable)

716747-171 Keyboard with backlight for use in Saudi Arabia (includes backlight cable and keyboard cable)

716747-201 Keyboard with backlight for use in Brazil (includes backlight cable and keyboard cable)

716747-211 Keyboard with backlight for use in Hungary (includes backlight cable and keyboard cable)

716747-251 Keyboard with backlight for use in Russia (includes backlight cable and keyboard cable)

716747-261 Keyboard with backlight for use in Bulgaria (includes backlight cable and keyboard cable)

716747-271 Keyboard with backlight for use in Romania (includes backlight cable and keyboard cable)

716747-281 Keyboard with backlight for use in Thailand (includes backlight cable and keyboard cable)

716747-291 Keyboard with backlight for use in Japan (includes backlight cable and keyboard cable)

716747-A41 Keyboard with backlight for use in Belgium (includes backlight cable and keyboard cable)

716747-AB1 Keyboard with backlight for use in Taiwan (includes backlight cable and keyboard cable)

716747-AD1 Keyboard with backlight for use in South Korea (includes backlight cable and keyboard cable)

716747-B31 Keyboard with backlight for use in the Netherlands (includes backlight cable and keyboard cable)

716747-B71 Keyboard with backlight for use in Sweden and Finland (includes backlight cable and
keyboard cable)

716747-BA1 Keyboard with backlight for use in Slovenia (includes backlight cable and keyboard cable)

716747-BB1 Keyboard with backlight for use in Israel (includes backlight cable and keyboard cable)

716747-BG1 Keyboard with backlight for use in Switzerland (includes backlight cable and keyboard cable)

716747-D61 Keyboard with backlight for use in India (includes backlight cable and keyboard cable)
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Spare part number Description

716747-DD1 Keyboard with backlight for use in Canada (includes backlight cable and keyboard cable)

716747-FL1 Keyboard with backlight for use in the Czech Republic and Slovakia (includes backlight cable and
keyboard cable)

716747-FP1 Keyboard with backlight for use in Northwest Africa (includes backlight cable and keyboard cable)

716748-001 128-GB solid-state drive

716749-001 256-GB solid-state drive
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4 Removal and replacement
procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screw driver

● Magnetic screw driver

● Phillips P0 and P1 screw drivers

● Torx T8 screw driver

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.
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Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.

Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the
operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by
different activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V

28 Chapter 4   Removal and replacement procedures



Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screw drivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastics Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 39 screws that must be removed, replaced, and/or loosened when servicing
the computer. Make special note of each screw size and location during removal and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag. It is necessary to remove the battery to obtain these numbers. See Battery
on page 33 for battery removal instructions.

Item Component Description

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.
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Item Component Description

(3) Part number/Product number (p/n) This number provides specific information about the
product’s hardware components. The part number helps
a service technician determine what components and
parts are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.
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Battery

Description Spare part number

6-cell, 44-Wh, 1.98-Ah, Li-ion battery (includes rubber feet and speaker grilles) 698943-001

Before removing the battery, follow these steps:

CAUTION: Removing a battery that is the sole power source for the computer can cause loss of
information. To prevent loss of information, save your work and initiate Hibernation or shut down the
computer through Windows before removing the battery.

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you.

2. Slide the battery release latch (1) to release the battery.

3. Pivot the battery up and then remove the battery from the computer (2).

To insert the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you.

2. Insert the battery at a 45-degree angle into the battery bay until it is seated.

3. Pivot the battery downwards until it is seated.

The battery release latch automatically locks the battery into place.
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Service cover

Description Spare part number

Service cover (includes 4 captive retention screws and 2 rubber feet) 716737-001

Before removing the service cover, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 33).

Remove the service cover:

1. Turn the computer upside down, with the front toward you.

2. Press on the micro SD Card bezel (1) once to release the bezel, and then press on the bezel
again to remove the bezel.

The micro SD Card bezel is included in the Plastics/Rubber Kit, spare part number 716744-001.

3. Remove the two large rubber screw covers (2).

4. Remove the two Phillips PM2.0×6.5 screws (3) that secure the service cover to the computer.

5. Remove the two small rubber screw covers (4).

The large and small rubber screw covers are included in the Plastics/Rubber Kit, spare part
number 716744-001.
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6. Remove the two Phillips PM2.0×8.5 screws (5) that secure the service cover to the computer.

7. Loosen the four captive Phillips screws (1) that secure the service cover to the computer.

8. Lift the front edge of the service cover (2) until the cover detaches from the computer, and then
remove the service cover (3) from the computer.

Reverse this procedure to install the service cover.
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WWAN module

Description Spare part number

HP un2430 EV-DO/HSPA Mini Card 702080-001

HP hs2350 HSPA+ Mobile Broadband Module 710788-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.

Before removing the WWAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the service cover (see Service cover on page 34).

Remove the WWAN module:

1. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

NOTE: The WWAN antenna cable labeled “5” connects to the WWAN module “Main”
terminal. The WWAN antenna cable labeled “6” connects to the WWAN module “Aux” terminal.

2. Remove the Phillips PM2.0×3.0 screw (2) that secures the WWAN module to the computer. (The
WWAN module tilts up.)
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3. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

NOTE: If the WWAN antenna cables are not connected to the terminals on the WWAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WWAN module.
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WLAN module

Description Spare part number

Intel Centrino Advanced-N 6235 Combo Adapter 670292-001

Intel Centrino Advanced-N 6205 Combo Adapter 695915-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the service cover (see Service cover on page 34).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal.
The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal.

2. Remove the Phillips PM2.0×3.0 screw (2) that secures the WLAN module to the computer. (The
WLAN module tilts up.)
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3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: If the WLAN antenna cables are not connected to the terminals on the WLAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.
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Solid-state drive

Description Spare part number

256-GB 716749-001

128-GB 716748-001

Before removing the solid-state drive, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the service cover (see Service cover on page 34).

Remove the solid-state drive:

1. Remove the Phillips PM2.0×3.0 screw (1) that secures the solid-state drive to the computer. (The
solid-state drive tilts up.)

2. Remove the solid-state drive (2) by pulling the drive away from the slot at an angle.

Reverse this procedure to install the solid-state drive.
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Memory module

Description Spare part number

8-GB (PC3L, 12800, 1600-MHz) 693374-001

4-GB (PC3L, 12800, 1600-MHz) 691740-001

Update BIOS before adding memory modules

Before adding new memory, make sure you update the computer to the latest BIOS.

CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may
result in various system problems.

To update BIOS:

1. Navigate to www.hp.com.

2. Click Support & Drivers > click Drivers & Software.

3. In the Enter a product name/number box, type the computer model information, and then
click Search.

4. Click the link for the computer model.

5. Select the operating system, and then click Next.

6. Under Step 2: Select a Download, click the BIOS link.

7. Click the link for the most recent BIOS.

8. Click the Download button, and then follow the on-screen instructions.

Before removing a memory module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the service cover (see Service cover on page 34).

Remove the memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The memory module tilts up.)
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2. Remove the memory module (2) by pulling the module away from the slot at an angle.

Reverse this procedure to install a memory module.
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NFC board

Description Spare part number

NFC board (includes NFC board cable) 716738-001

Before removing the NFC board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the service cover (see Service cover on page 34).

Remove the NFC board:

1. Disconnect the NFC antenna cable (1) from the NFC board.

The NFC antenna cable is included in the bottom cover spare part kit, spare part number .

2. Release the zero insertion force (ZIF) connector (2) to which the NFC board cable is attached,
and then disconnect the NFC board cable from the system board.

3. Detach the NFC board cable (3) from the bottom cover. (The NFC board cable is attached to the
bottom cover with double-sided tape.)

4. Remove the Phillips PM1.5×2.0 screw (4) that secures the NFC board to the bottom cover.

5. Remove the NFC board (5) and cable.
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Reverse this procedure to install the NFC board.

Keyboard

NOTE: The keyboard spare part kit includes a backlight cable, keyboard, and keyboard cable.

For use in country/region Spare part number For use in country/region Spare part number

For use in Belgium 716747-A41 For use in Norway 716747-091

For use in Brazil 716747-201 For use in Northwest Africa 716747-FP1

For use in Bulgaria 716747-261 For use in Portugal 716747-131

For use in Canada 716747-DB1 For use in Romania 716747-271

For use in the Czech Republic
and Slovakia

716747-FL1 For use in Russia 716747-251

For use in Denmark 716747-081 For use in Saudi Arabia 716747-171

For use in France 716747-051 For use in Slovenia 716747-BA1

For use in Germany 716747-041 For use in South Korea 716747-AD1

For use in Greece 716747-151 For use in Spain 716747-071

For use in Hungary 716747-211 For use in Sweden and Finland 716747-B71

For use in Iceland 716747-DD1 For use in Switzerland 716747-BG1

For use in India 716747-D61 For use in Taiwan 716747-AB1

For use in Israel 716747-BB1 For use in Thailand 716747-281

For use in Italy 716747-061 For use in Turkey 716747-141

For use in Japan 716747-291 For use in the United Kingdom
and Singapore

716747-031

For use in Latin America 716747-161 For use in the United States 716747-001

For use in the Netherlands 716747-B31  

Before removing the keyboard, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the service cover (see Service cover on page 34).
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Remove the keyboard:

1. Loosen the 2 captive screws that secure the keyboard to the computer.

2. Rest and secure the computer on its left side.

3. Partially open the computer.

4. Insert a screw driver or similar thin tool into the keyboard release hole near the fan, and then
press on the back of the keyboard until the keyboard disengages from the computer.

5. Turn the computer right-side up with the front toward you.

6. Open the computer.
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7. Lift the rear edge of the keyboard, and then swing the keyboard up and forward until it rests
upside down on the palm rest.

8. Release the ZIF connector (1) to which the backlight cable is attached, and then disconnect the
backlight cable (2) from the system board.

9. Release the ZIF connector (3) to which the keyboard cable is attached, and then disconnect the
keyboard cable (4) from the system board.
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10. Remove the keyboard (5).

Reverse this procedure to install the keyboard.
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Bottom cover

Description Spare part number

Bottom cover (includes battery release latch, NFC board antenna cable, power connector cover,
and RJ-45 jack cover)

716739-001

Before removing the bottom cover, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 33).

5. Remove the service cover (see Service cover on page 34).

6. Remove the keyboard (see Keyboard on page 44).

Remove the bottom cover:

1. Remove the two Phillips PM2.0×4.3 screws that secure the bottom cover to the computer.

2. Close the computer.

3. Turn the computer upside down, with the rear toward you.

4. Disconnect the microphone cable (1) from the system board.
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5. Release the tape (2) and (3) that secures the WWAN antenna cables and the WLAN antenna
cables.

6. Remove the five Torx T8M2.0×5.65 screws (1) and the Torx T8M2.0×2.5 screw (2) that secure
the bottom cover to the computer.
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7. Remove the bottom cover.

Reverse this procedure to install the bottom cover.

Speakers

Description Spare part number

Front speakers (includes left and right speakers, cables, and 4 rubber isolators) 716740-001

Before removing the speakers, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 33), and then remove the following components:

a. Service cover (see Service cover on page 34)

b. Keyboard (see Keyboard on page 44)

c. Bottom cover (see Bottom cover on page 48)

Remove the speakers:

1. Disconnect the speaker cables (1) from the system board.

2. Release the left speaker cable (2) from the clips built into the top cover.

3. Remove the three Phillips PM2.0×3.0 broad head screws (3) that secure the speakers to the
top cover.
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4. Remove the speakers (4).

Reverse this procedure to install the speakers.
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Button board

Description Spare part number

Button board (includes cable) 716735-001

Before removing the button board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 33), and then remove the following components:

a. Service cover (see Service cover on page 34)

b. Keyboard (see Keyboard on page 44)

c. Bottom cover (see Bottom cover on page 48)

d. Right speaker (see Speakers on page 50)

Remove the button board:

1. Turn the computer right side up, with the front toward you.

2. Open the computer.

3. Release the ZIF connector (1) to which the button board cable is attached, and then disconnect
the button board cable (2) from the system board.

4. Close the computer.
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5. Turn the computer upside down, with the rear toward you.

6. Detach the button board (1) from the top cover. (The button board cable is attached to the the top
cover with double-sided tape.)

7. Remove the Phillips PM2.0×3.0 screw (2) that secures the button board to the top cover.

8. Remove the button board (3).

Reverse this procedure to install the button board.
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RTC battery

NOTE: The RTC battery is also included with the system board spare part kit.

Description Spare part number

RTC battery (includes cable and double-sided adhesive) 716742-001

Before removing the RTC battery, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 33), and then remove the following components:

a. Service cover (see Service cover on page 34)

b. Keyboard (see Keyboard on page 44)

c. Bottom cover (see Bottom cover on page 48)

Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the system board.

2. Detach the RTC battery (2) from the top cover. (The RTC battery is attached to the system board
with double-sided tape.)

3. Remove the RTC battery.
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Reverse this procedure to install the RTC battery.

Fan/heat sink assembly

Description Spare part number

Fan/heat sink assembly (includes replacement thermal material) 716736-001

Before removing the fan/heat sink assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 33), and then remove the following components:

a. Service cover (see Service cover on page 34)

b. Keyboard (see Keyboard on page 44)

c. Bottom cover (see Bottom cover on page 48)

Remove the fan/heat sink assembly:

1. Disconnect the fan cable (1) from the system board.

2. Following the 1, 2, 3, 4 sequence stamped into the fan/heat sink assembly, loosen the four
captive Phillips PM2.0×6.5 screws (2) that secure the fan/heat sink assembly to the system board.
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3. Remove the fan/heat sink assembly (3).

NOTE: Due to the adhesive quality of the thermal material located between the fan/heat sink
assembly and the system board components, it may be necessary to move the fan/heat sink
assembly from side to side to detach it.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the fan/heat sink
assembly and the processor each time the fan/heat sink assembly is removed. Replacement thermal
material is included with the fan/heat sink assembly and system board spare part kits. Thermal paste is
used on the processor (1) and the section of the fan/heat sink assembly (2) that services it.

Reverse this procedure to install the fan/heat sink assembly.
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System board

Description Spare part number

Equipped with an Intel Dual Core i7-3687U 2.10-GHz (turbo up to 3.30-GHz), 1600-MHz FSB,
4.00-MB L3 cache, 17 W, and the Windows 8 Professional operating system

716733-601

Equipped with an Intel Dual Core i7-3687U 2.10-GHz (turbo up to 3.30-GHz), 1600-MHz FSB,
4.00-MB L3 cache, 17 W, and the Windows 8 Standard operating system

716733-501

Equipped with an Intel Dual Core i7-3687U 2.10-GHz (turbo up to 3.30-GHz), 1600-MHz FSB,
4.00-MB L3 cache, 17 W, and the Windows 7 operating system

716733-001

Equipped with an Intel Dual Core i5-3437U 1.90-GHz (turbo up to 2.90-GHz), 1600-MHz FSB,
3.00-MB L3 cache, 17 W, and the Windows 8 Professional operating system

716732-601

Equipped with an Intel Dual Core i5-3437U 1.90-GHz (turbo up to 2.90-GHz), 1600-MHz FSB,
3.00-MB L3 cache, 17 W, and the Windows 8 Standard operating system

716732-501

Equipped with an Intel Dual Core i5-3437U 1.90-GHz (turbo up to 2.90-GHz), 1600-MHz FSB,
3.00-MB L3 cache, 17 W, and the Windows 7 operating system

716732-001

Equipped with an Intel Dual Core i3-3227U 1.90-GHz processor, 1600-MHz FSB, 3.00-MB L3
cache, 17 W, and the Windows 8 Professional operating system

716731-601

Equipped with an Intel Dual Core i3-3227U 1.90-GHz processor, 1600-MHz FSB, 3.00-MB L3
cache, 17 W, and the Windows 8 Standard operating system

716731-501

Equipped with an Intel Dual Core i3-3227U 1.90-GHz processor, 1600-MHz FSB, 3.00-MB L3
cache, 17 W, and the Windows 7 operating system

716731-001

Before removing the system board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 33), and then remove the following components:

a. Service cover (see Service cover on page 34)

b. WWAN module (see WWAN module on page 36)

c. WLAN module (see WLAN module on page 38)

d. Solid-state drive (see Solid-state drive on page 40)

e. Keyboard (see Keyboard on page 44)

f. Bottom cover (see Bottom cover on page 48)

g. Right speaker (see Speakers on page 50)

h. Fan/heat sink assembly (see Fan/heat sink assembly on page 55)
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NOTE: When replacing the system board, be sure that the following components are removed from
the defective system board and installed on the replacement system board:

● Memory module (see Memory module on page 41)

● RTC battery (see RTC battery on page 54)

Remove the system board:

1. Turn the computer right side up, with the front toward you.

2. Open the computer.

3. Release the ZIF connector (1) to which the TouchPad cable is attached, and then disconnect the
TouchPad cable (2) from the system board.

4. Disconnect the display panel cable (1) from the system board.

5. Remove the Phillips PM2.0×2.5 screw (2) that secures the system board to the top cover.
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6. Remove the system board (3).

Reverse this procedure to install the system board.

Hinge cover

Description Spare part number

Hinge cover (includes hinge cap, WWAN antenna cables and transceivers, and WWAN antenna
shield)

716743-001

Before removing the hinge cover, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 33), and then remove the following components:

a. Service cover (see Service cover on page 34)

b. WWAN module (see WWAN module on page 36)

c. WLAN module (see WLAN module on page 38)

d. Solid-state drive (see Solid-state drive on page 40)

e. Keyboard (see Keyboard on page 44)

f. Bottom cover (see Bottom cover on page 48)

g. Fan/heat sink assembly (see Fan/heat sink assembly on page 55)

h. System board (see System board on page 57)
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Remove the hinge cover:

1. Remove the shield (1) that secures the WWAN antenna cables (2) in the routing channel built
into the top cover.

2. Remove the six Phillips PM2.0×2.5 screws (2) that secure the hinge cover to the top cover.

3. Turn the computer right side up, with the front toward you.

4. Open the computer.

5. Rotate the display assembly (1) clockwise until it is perpendicular to the computer body.

6. Detach the left (2) and right edges of the hinge cover from the computer.

7. Remove the hinge cover (3) by sliding it away from the computer.
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8. Remove the hinge cap (4).

Reverse this procedure to install the hinge cover and hinge cap.

Display assembly

Description Spare part number

Hinge cover (includes hinge cap, WWAN antenna cables and transceivers,
and WWAN antenna shield)

716743-001

Before removing the display assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 33), and then remove the following components:

a. Service cover (see Service cover on page 34)

b. WWAN module (see WWAN module on page 36)

c. WLAN module (see WLAN module on page 38)

d. Solid-state drive (see Solid-state drive on page 40)

e. Keyboard (see Keyboard on page 44)

f. Bottom cover (see Bottom cover on page 48)
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g. Fan/heat sink assembly (see Fan/heat sink assembly on page 55)

h. System board (see System board on page 57)

i. Hinge cover and hinge cap (see Hinge cover on page 59)

Remove the display assembly:

1. Remove the two Phillips PM2.0×5.0 screws (1) that secure the display assembly to the top cover.

2. Slide the display assembly (2) away from the top cover and remove it.

Reverse this procedure to install the display assembly.
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5 Computer Setup (BIOS) and
Advanced System Diagnostics

Using Computer Setup
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of the
computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.
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NOTE: You can use either a pointing device (TouchPad or USB mouse) or the keyboard to
navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes:

Click the Exit icon in the lower-left corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

● To save your changes and exit Computer Setup menus:

Click the Save icon in the lower-left corner of the screen, and then follow the on-screen
instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the
factory settings.
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Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.
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Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. From the Start screen, select the HP Support Assistant app.

2. Select Updates and tune-ups, and then select Check for HP updates now.

3. At the download area, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is
downloaded. You will need to access this path when you are ready to install the update.

NOTE: NOTE: If you connect your computer to a network, consult the network administrator
before installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. From the Start screen, type e, and then click File Explorer.

2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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Using Advanced System Diagnostics
Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

● System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

● Start-up test—This test analyzes the main computer components that are required to start
the computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact HP support to report the issue and purchase a
replacement battery.

● BIOS Management—You can update or rollback the version of the BIOS on the system. Do not
shut down or remove external power during the process. You will be given a confirmation
screen before your BIOS is modified. Select BIOS update, BIOS Rollback, or Back to
main menu.

You can view system information and error logs or select languages in the Advanced System
Diagnostics window.

To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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6 Specifications

Computer specifications

 Metric U.S.

Dimensions

Width 28.5 cm 11.22 in

Depth 21.2 cm 8.35 in

Height 2.22 cm 0.87 in

Weight (equipped with 4096-MB memory module,
mSATA solid-state drive, 6-cell battery, and WLAN
module)

1.40 kg 3.09 lbs

Input power

Operating voltage and current 18.5 Vdc @ 3.5 A – 65 W

19.5 Vdc @ 3.33 A – 65 W

19 Vdc @ 4.74 A – 90 W

19.5 Vdc @ 4.62 A – 90 W

19.5Vdc @ 2.31A – 45W

Temperature

Operating 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.
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11.6-inch UWVA display specifications

 Metric U.S.

Dimensions

Height 14.50 cm 5.71 in

Width 25.70 cm 10.12 in

Diagonal 29.40 cm 11.58 in

Number of colors Up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 400 nits (typical)

Pixel resolution

Pitch 0.197 × 0.197 mm

Format 1366 × 768

Configuration RGB vertical stripe

Backlight LED backlit

Character display 80 × 25

Total power consumption 3.46 W

Viewing angle ±65° horizontal, ±50° vertical (typical)
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7 Backup and recovery

Windows 8
To protect your information, use Windows backup and restore utilities to back up individual files and
folders, back up your entire hard drive, create system repair media (select models only) by using the
installed optical drive (select models only) or an optional external optical drive, or create system restore
points. In case of system failure, you can use the backup files to restore the contents of your computer.

From the Start screen, type restore, click Settings, and then select from the list of displayed options.

NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in HP Support Assistant. To access HP Support Assistant on the Start screen, select the HP
Support Assistant app.

In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to HP Support Assistant. To access HP Support Assistant
on the Start screen, select the HP Support Assistant app.

Backing up your information

Recovery after a system failure is as good as your most recent backup. You should create system repair
media and your initial backup immediately after initial system setup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup. The system repair media (select models only) are used to start up (boot) the computer
and repair the operating system in case of system instability or failure. Your initial and subsequent
backups allow you to restore your data and settings if a failure occurs.

On Start screen, type backup, click Settings, and then select Save backup copies of your files
with File History.

You can back up your information to an optional external hard drive or a network drive.
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Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Backup and Restore:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. From the Start screen, type backup, click Settings, and then select from the list of
displayed options.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create system repair media (select models only).

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Automatic Repair to fix problems that
might prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created (select models only), you must purchase Windows 8 operating system
media to reboot the computer and repair the operating system.

Using the Windows recovery tools

To recover information you previously backed up:

▲ Access HP Support Assistant. To access HP Support Assistant on the Start screen, select the HP
Support Assistant app.

To recover your information using Automatic Repair, follow these steps:
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CAUTION: Some Automatic Repair options will completely erase and reformat the hard drive. All
files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition and the Windows partition.

From the Start screen, type e, and then click File Explorer.

– or –

From the Start screen, type c, and then select Computer.

NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 8 operating system DVD and the Driver
Recovery media (both purchased separately). For additional information, see Using Windows 8
operating system media (purchased separately) on page 73.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer. After
Windows has loaded, press and hold the shift key while clicking Restart.

4. Select Troubleshoot, then select Advanced Options, and then select Automatic Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support Assistant. To access HP Support Assistant on the Start
screen, select the HP Support Assistant app.

Using f11 recovery tools

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that were
installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: From the Start screen, type C, and
then select Computer.

NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 8 operating system media and the Driver Recovery media (both
purchased separately). For additional information, see Using Windows 8 operating system media
(purchased separately) on page 73.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

72 Chapter 7   Backup and recovery



4. Press f11 while the “Press <F11>for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using Windows 8 operating system media (purchased separately)

To order a Windows 8 operating system DVD, go to http://www.hp.com/support, select your country
or region, and follow the on-screen instructions. You can also order the DVD by calling support. For
contact information, see the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 8 operating system media completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 8 operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 8 operating system DVD into the optical drive
before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 8 operating system media and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Using Windows Refresh for quick and easy recovery

When your computer is not working properly and you need to regain system stability, the Windows
Refresh option allows you to start fresh and keep what is important to you.

IMPORTANT: Refresh removes any traditional applications that were not originally installed on the
system at the factory.

NOTE: During Refresh, a list of removed traditional applications will be saved so that you have a
quick way to see what you might need to reinstall. See HP Support Assistant for instructions on
reinstalling traditional applications. To access HP Support Assistant on the Start screen, select the HP
Support Assistant app.

NOTE: You may be prompted for your permission or password when using Refresh. See Windows
Help and Support for more information. To access HP Support Assistant on the Start screen, select the
HP Support Assistant app.
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To start Refresh:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display
the charms.

2. Click Settings.

3. Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4. Under Refresh your PC without affecting your files, select Get started, and follow the
on-screen instructions.

Remove everything and reinstall Windows

Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option removes
all personal data, apps, and settings from your computer, and reinstalls Windows.

IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.

You can initiate this option by using the f11 key or from the Start screen.

To use the f11 key:

1. Press f11 while the computer boots.

– or –

Press and hold f11 as you press the power button.

2. Select Troubleshoot from the boot options menu.

3. Select Reset your PC, and follow the on-screen instructions.

To use the Start screen:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display
the charms.

2. Click Settings.

3. Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4. Under Remove everything and reinstall Windows, select Get started, and follow the
on-screen instructions.
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Using HP Software Setup

HP Software Setup can be used to reinstall drivers or select software that has been corrupted or deleted
from the system.

1. From the Start screen, type HP Software Setup, and select Apps.

2. Open HP Software Setup.

3. Follow the on-screen directions to reinstall drivers or select software.

Windows 7
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only) with
the installed optical drive (select models only) or an optional external optical drive, or create system
restore points. In case of system failure, you can use the backup files to restore the contents of
your computer.

Windows Backup and Restore provides the following options:

● Creating a system repair disc (select models only) by using the installed optical drive (select
models only) or an optional external optical drive

● Backing up your information

● Creating a system image (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. See Help and Support for more information.
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Creating recovery media with HP Recovery Disc Creator

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery
media. After you successfully set up the computer, you can create recovery media using HP Recovery
Disc Creator. This recovery media performs a system recovery if the hard drive becomes corrupted. A
system recovery reinstalls the original operating system and the software programs installed at the
factory, and then configures the settings for the programs.

HP Recovery Disc Creator can create two kinds of recovery DVDs as follows:

● Windows DVD—Installs the operating system without additional drivers or applications. Choosing
this selection creates a DVD that restores the original operating system and the software programs
installed at the factory.

● Driver DVD—Installs specific drivers and applications only, in the same way that the HP Software
Setup utility installs drivers and applications.

Creating recovery media

NOTE: Operating system recovery media can be created only once. Thereafter, the option to create
that media will not be available.

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Driver DVD or Windows DVD.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Burn button to start the burning process.

Backing up your information

Recovery after a system failure is as good as your most recent backup. Immediately after software
setup, you should create system repair discs (select models only) using HP Recovery Disc Creator using
the installed optical drive (select models only) or an optional external optical drive and back up your
system. As you add new software and data files, you should continue to back up your system on a
regular basis to maintain a reasonably current backup. The system repair discs (select models only) are
used to start up (boot) the computer and repair the operating system in case of system instability or
failure. Your initial and subsequent backups allow you to restore your data and settings if a
failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the
type of optical drive you are using.
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NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the external drive.

To create a backup using Backup and Restore:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of
the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair discs
you previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. For additional information, see Using a Windows
7 operating system DVD (purchased separately) on page 79.

Using the Windows recovery tools

To recover information you previously backed up:

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

To recover your information using Startup Repair, follow these steps:
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CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive.
All files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition.

To check for the Windows partition, select Start > Computer.

To check for the HP Recovery partition, click Start, right-click Computer, click Manage, and
then click Disk Management.

NOTE: If the HP Recovery partition has been deleted, the f11 restore option will not function.
You must recover your operating system and programs using the Windows 7 operating system
DVD and the Driver Recovery disc (both purchased separately) if the Windows partition and the
HP Recovery partition are not listed. For additional information, see Using a Windows 7 operating
system DVD (purchased separately) on page 79.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer, and then
press f8 before the Windows operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11 recovery tools

CAUTION: Using f11 recovery tools completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently removed.
The f11 recovery tool reinstalls the operating system and HP programs and drivers that were installed at
the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: click Start, right-click Computer,
click Manage, and then click Disk Management.

NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, see Using a Windows 7 operating system DVD
(purchased separately) on page 79.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using a Windows 7 operating system DVD (purchased separately)

To order a Windows 7 operating system DVD, contact support. For U.S. support, go to
http://www.hp.com/go/contactHP. For worldwide support, go to http://welcome.hp.com/country/
us/en/ wwcontact_us.html. You can also order the DVD by calling support. For contact information,
see the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive
before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 7 operating system DVD, and then insert the Driver Recovery disc.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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8 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.0 m (3.3 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China COC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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9 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose
of the battery in general household waste. Follow the local laws and regulations in your area for
battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, see the HP Web site at
http://www.hp.com/recycle.
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